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Discover the Meaning of Alt Gr, Pause, and the
Other Unusual Keys on a Computer Keyboard

Computer keyboards are puzzling things.
Like a typewriter, they contain all the keys we
need for typing text, numbers and punct-
uation, but where a typewriter keyboard
stops, the computer keyboard just keeps
going, giving us a total of 105 keys.

Are they really all necessary, and if they are,
what on earth could they all do? In this
article, I’ll explain what those mysterious extras are for
(or, in some cases, what they used to be for) and when
you might use them.

Contents:

Introducing the Standard 105-key Keyboard  .......................

An Alphabetical List of the Keys on a 
Standard Keyboard  ...................................................................

Keys May Behave Differently in Certain Programs!..............

K 168/2

K 168/3

K 168/14

This article shows you:
• The keys you’ll find on a standard computer

keyboard
• What each key on a keyboard is used for
• How unusual keys like Scroll Lock and Pause 

were used
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Introducing the Standard 105-key Keyboard

Until the mind-1990s we used to talk about the ‘standard
102-key computer keyboard’. The fact that such a term
existed indicates that keyboards had had rather a lot of
keys for quite a long time.

Part of the reason for this is that early computers didn’t
have a mouse – indeed, they didn’t display anything on
the screen that a mouse-like device could control – so the
only way to control your computer was via the keyboard.
And just as the mouse has gradually gained a wheel and
additional buttons to help us do things with one click
rather than several, keyboards quickly gained extra keys
to help users do things with one key-press.

Despite the arrival of the mouse, computer keyboards
have continued to gain keys. When Windows 95 arrived,
Microsoft decided it would be useful for keyboards to
have three extra keys – two ‘Windows’ keys and a ‘Menu’
key – and keyboard manufacturers duly obliged, giving us
the now-standard 105-key keyboard.

More recently still, many manufacturers have started
adding extra buttons to their keyboards for controlling
your web browser, adjusting the volume of your speakers,
playing and pausing your media player, opening the
Calculator accessory, and more. Although these buttons
can’t really be classed as ‘keys’, they do show that the
evolution of the humble keyboard is continuing.

It’s an unusual evolution, though. In the animal world, the
bits and pieces that serve no useful function either evolve
a different use or shrivel up and disappear. On the
keyboard, as we’ll see, there are keys that do nothing very
useful on modern computers, but no-one has yet assigned
them a new job to do, and they certainly don’t seem to be
shrivelling up!
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An Alphabetical List of the Keys on a
Standard Keyboard

Without further ado, let’s take a tour of the keyboard
and find out what all those keys do – or did! I’ll explain
them in alphabetical order, to make each one easier to
find, and I’ll throw in a few examples and tips along the
way to point out uses you may not have discovered for
the keys.

Alt
You’ll find the Alt key immediately to the left of the
Space bar (not to be confused with the Alt Gr key to the
right, which I’ll come to next). Short for ‘Alternate’, this
is one of three ‘modifier’ keys on a keyboard (the other
two being Ctrl and Shift). A modifier key doesn’t usually
do anything by itself, but it’s used in combination with
other keys to make something happen. For instance,
pressing Alt+F4 closes the window you’re using;
selecting any file or folder and pressing Alt+Enter
displays the item’s Properties dialog; and pressing
Alt+Tab switches back and forth between the two open
windows you’ve been using most recently.

Perhaps the most common use of the Alt key in
Windows is to let you navigate a program’s menu bar
using the keyboard. Let’s take the Notepad accessory as
a typical example: press the Alt key and one letter of
each item on the menu bar gains an underline. Type one
of those letters (such as f for the File menu) and the
corresponding menu opens. You’ll see that each item on
that menu also has a single underlined letter, such as x
for Exit: press the letter for the action you want. Once
you get used to the combinations you use most, you’ll
find you can tap out, for example, Alt then f then x in
quick succession to exit Notepad.

Some programs do have a menu bar but it’s hidden.
Examples are Internet Explorer, Windows Media Player
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and Mozilla Firefox. In those cases, pressing the Alt
key displays the menu bar. If you’re using a program
that doesn’t seem to have a menu bar, pressing Alt is
a good way to find out whether it does or not: if it
turns out not to, that key-press shouldn’t have caused
anything else to happen.

The Alt key also offers a keyboard-driven way to
navigate in dialog boxes and select options. As an
example, start Notepad and choose Edit > Replace (or
Alt then e then r if you prefer). When the Replace dialog
appears, press the Alt key and each control (or the label
beside the control) gains an underlined letter. You’ll see
that you can jump to the ‘Replace with’ box by pressing
Alt+P, click the ‘Replace All’ button with Alt+A, or tick
or untick the ‘Match case’ checkbox by pressing Alt+C.

Alt Gr

This is short for ‘Alternate Graphic’ (although no-one
seems to know what that means) and it’s found to the
right of the Space bar. This key does nothing when used
by itself, but your computer treats it as if you’d pressed
the Ctrl+Alt keys together, providing a different and
slightly easier way to use key combinations that involve
pressing Ctrl+Alt and a third key.

Here’s an example of using Alt Gr. Most modern
keyboards show a Euro currency symbol on the 4 key. To
type a Euro symbol you press Ctrl+Alt+4, or you can use
the slightly-easier combination of Alt Gr+4.

Arrow keys

The arrow keys are arranged in a pyramid shape to the
right of the keyboard’s main collection of keys. They
move the cursor in any direction in a text document 
or spreadsheet, or select the next or previous item in 
a list.
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Backspace

Found at the far-right of the top row of the keyboard,
this deletes the last character you typed, or the character
to the left of the cursor. In a web browser, it takes you
back to the last page you were viewing (equivalent to
clicking the Back button), and in File Explorer it takes
you back to the previous folder.

Break

This does nothing useful on modern Windows systems.
In old systems, once a program started running and
outputting its stream of results, it would continue until
it had finished (which might be minutes, days, or never).
The Break key could be used to make it stop.

Caps Lock

When switched on (usually indicated by a lamp on the
key itself, or elsewhere on the keyboard), every letter
key you press will be typed as a capital letter (and you
can use Shift when you need to type a lowercase letter).

Unlike a typewriter, the Caps Lock mode only affects the
letter keys, not the number or symbol keys. So if you
want one of the secondary characters, such as % or ? or
£, you must still press the Shift key.

Ctrl

Short for ‘Control’, this is another of the keyboard’s
modifier keys (along with Alt and Shift). Your keyboard
has two Ctrl keys, in the bottom-left and bottom-right
corners, and you can use whichever is easier to reach at
the time.

The Ctrl keys are used in combination with other keys to
provide quick keyboard shortcuts in programs, reducing
the need to reach for the mouse and grapple with
menus and toolbars. There are two typical ways to
discover a program’s keyboard shortcuts:
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• If the program has a toolbar or Ribbon, hold the
mouse over a button and a tooltip should pop up to
tell you its shortcut.

• If the program has a menu bar, you should see key-
board shortcuts noted to the right-hand side of the
menu.

Delete

The Delete key erases whatever you’ve selected: some
text in a document, an area of a picture, a cell in a
spreadsheet, or anything else. In File Explorer, it removes
the file(s) and/or folder(s) you’ve selected and sends
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them off to the Recycle Bin: only if you ‘delete’
something from the Recycle Bin itself is it actually
deleted from your hard drive. In a word processor, or
anywhere else you’ve typed text, pressing Delete erases
the character to the right of the cursor.

End

This is the partner to the Home key, explained later in
this article. You use it to jump to the last icon in a folder,
the bottom of a list or a web page, or the end of the
current line in a document. Pressing Ctrl+End takes you
to the end of a document.

Enter (also known as Return)

The main Enter key is at the far-right of the keyboard’s
main collection of keys, and is usually a large irregularly-
shaped key. When writing a text document, press this
key to start a new paragraph or a new line in a list. It’s
the equivalent of the carriage-return lever on a
typewriter. The only difference is that you don’t need to
press it when you reach the right-hand edge of the
page, because the program you’re using will give you a
new line automatically.

The group of keys known as the ‘numeric keypad’ at
the far right of the keyboard also sports an Enter key.
Pressing either of these does the same thing, so you
can use whichever is the easier to reach. 

The Enter key also has a couple of mouse-saving uses:

• If you see a message dialog offering you a choice of
Yes/No or OK/Cancel buttons, one of these buttons
will be the default (or recommended) button,
recognisable by a bold blue or black border. If that’s
the button you want to click, you can press Enter
instead of using the mouse.
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• The Enter key does the same as a double-click when
a file or folder is selected in File Explorer: it opens the
folder or file or runs the program.

Esc

Short for ‘Escape’, this key does the same as clicking the
‘No’ or ‘Cancel’ button in a dialog. You can use it to
quickly dismiss messages that pop up to tell you an error
has occurred or a particular action is complete. (If a
message box appears with just an OK button, you can
press either Enter or Esc to close it – both do the same
thing in this situation.)

More generally, you can think of Esc as the ‘Stop it!’ key.
If a program has switched to a particular mode you want
to get out of, or something annoying is happening, a
press of the Esc key is a likely way to put an end to it (and
it’s unlikely to make anything worse).

Fn

The Fn (short for ‘Function’) key is usually found only on
notebook computers, although a few special compact
keyboards also have it. The key is usually found some-
where near the bottom-left corner of the keyboard, and
the letters ‘Fn’ are often shown in blue or orange.

The Fn key is used in combination with other keys on the
keyboard, and those keys will also have small symbols on
them in the same colour as the Fn key. As an example,
one of the keys may have a small blue or orange picture
of the Sun on it: holding the Fn key and tapping that
Sun key will increase the brightness of your computer’s
screen.

Notebook computers usually have fewer keys on their
keyboards due to their size, which means that some
keys have to serve three different purposes. Just as the
Shift key is used to select the secondary purpose of a
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key (usually a capital letter or a symbol), the Fn key is
used to select its third purpose.

Function keys: F1, F2 and so on

The function keys form the topmost row of the
keyboard and there are usually twelve of them labelled
F1, F2, and so on up to F12.

These keys don’t have any specific purpose – what they
do (and whether they do anything at all) depends on the
program you’re using. When someone writes a program,
they can decide that a particular function key will carry
out a particular action, allowing users to carry out that
action with one quick key-press. As an example, in some
programs (notably the Microsoft Office programs such as
Word and Excel) you can press the F12 key as an
alternative to choosing File > Save As. In other programs,
though, the F12 key may do something different, or
nothing at all.

One thing that has become traditional in software
design is that the F1 key should be the ‘Help’ key.
Whatever program you’re using, and whatever you’re
doing, pressing F1 should display a help file explaining
how to use the program (or the part of it you’re
currently working with).

Home

This is the partner to the End key, mentioned earlier. You
use it to jump to the first icon in a folder, the top of a list
or a web page, or the beginning of the current line in a
document. Pressing Ctrl+Home takes you to the top of a
document.

Insert

The Insert key switches your keyboard back and forth
between two modes: Insert and Overtype. In Insert
mode, when you click in the middle of a sentence and
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start typing, the new text is inserted into the sentence,
pushing the existing text out of the way to make room.
In Overtype mode, each character you type replaces the
character to its right. If you find this happening while
you type, press Insert to switch from Overtype mode
back to Insert mode.

This is probably the most irritating key on the
keyboard, beating Caps Lock into second place. There’s
no indication you’re in Overtype mode: you only
realise when you discover you’re typing over existing
text. No-one ever switches to Overtype mode on
purpose, and for that reason an increasing number of
programs (notably Microsoft Word) disable this key. 

Menu

Along with the two Windows keys, mentioned later in
this article, the Menu key is a new addition to modern
keyboards. You’ll find it near the right-hand end of the
keyboard’s bottom row: it shows a picture of a small
menu with a mouse pointer hovering over it.

The Menu key was introduced for the benefit of
Windows users with a one-button mouse and, as a result,
no way of right-clicking things. (These days, of course,
none of us has a one-button mouse, and the Menu key
is largely unnecessary.) You can click something to select
it and then press the Menu key to display the context
menu that would appear when you right-click.

Num Lock and numeric keypad

Over to the far right of your keyboard there’s a block of
number and arithmetic keys, known as the numeric
keypad. These are dual-purpose keys: in the top left
corner of the block there’s a Num Lock key and this
determines which mode the numeric keypad is in. In one
mode, those keys act as a second set of Home, End, Page
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Up, Page Down and arrow keys. In the other mode,
which is far more useful, they become number keys. To
switch modes, press the Num Lock key; on most
keyboards, a light comes on to indicate that the keypad
is in ‘number mode’.

There are two especially useful things about the numeric
keypad. First, its numbers are laid out like a calculator or
telephone, in the places our fingers expect to find them
(unlike the number keys on the top row of the
keyboard). Second, it contains keys for Divide, Multiply,
Subtract and Add in accessible places. For example, to
reach the Multiply (asterisk) symbol in the main section
of the keyboard you have to press Shift+8, which is often
a job for two hands, whereas here everything falls under
one hand and needs only one key-press.

The numeric keypad is perfect for any program that lets
you enter numbers: the Windows Calculator accessory or
a spreadsheet, for example. You can also use it to type
numbers (such as your phone number) into a document,
or as a simpler way to type the ‘*’ and ‘+’ symbols. The
second Enter key on this keypad does exactly the same
as the main Enter key – they can be used inter-
changeably, and they double as the Equals sign in most
calculator programs.

Page Up and Page Down

These keys take you upwards or downwards in a long
document (or web page, or folder) in steps of roughly a
page or a screen at a time.

Pause

In Windows, the Pause key does absolutely nothing –
not a sausage. In old operating systems like MS-DOS , in
which immense amounts of text might appear on the
screen and scroll past before you had a chance to read
it, you could use the Pause key to pause the operation
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and read the text before allowing the next batch to
arrive.

This key does still have one use, however. If you press
Win+Pause, it opens a Control Panel window displaying
details about your computer and your version of
Windows.

Print Screen

On your keyboard, this might be abbreviated in all sorts
of strange ways, such as ‘PrtScn’ or ‘Prnt Scrn’. In the old
days (before the arrival of Windows), pressing this key
automatically printed on paper whatever text you could
see on the computer’s screen.

These days, it copies a picture of the screen to the
clipboard (or, if you hold the Alt key and press Print
Screen, it will copy a picture of just the window you’re
using). If you then start your favourite picture-editing
program, or the Paint program, and choose Paste, the
picture of your screen will appear in the program, and
you can edit, save or print it from there.

Scroll Lock

This may also be abbreviated in unusual ways, and it’s
generally found next to Print Screen. It’s an on/off
switch, like Caps Lock and Num Lock.

When switched on, it traditionally changed the way the
arrow keys worked, causing them to scroll the page up
and down or right and left, saving the need to use the
scrollbars. The vast majority of modern programs take
no notice of the Scroll Lock key, so it’s another key that’s
largely decorative these days. One program that does
take notice of it is Microsoft Excel: if you find that
pressing arrow keys in Excel scrolls the page rather than
moving the selection from cell to cell, that’s a sure sign
you’ve accidentally tapped the Scroll Lock key, so tap it
again to switch it off.
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Shift

There are two Shift keys, one at either side of the
keyboard, and you can use whichever is most
comfortable to reach at the time. These are used in
conjunction with other keys to type a capital letter or
the symbol shown at the top (rather than the bottom)
of the key.

Sys Rq

Short for ‘System Request’, this is another key that serves
no purpose on modern computers. In older systems such
as MS-DOS, it acted as a sort of ‘panic button’: if the
program you were using stopped responding and
locked up, you could use Sys Rq to force the system to
close it.

Tab

The Tab key is at the left of the keyboard, immediately
above the Caps Lock key. Its most common purpose is
the one it’s always had on a typewriter: indenting a line
of text from the left margin to the first (or next) tab
point.

Its other use is for jumping from one control to the next
in a dialog or a form on a web page. Imagine you’re
filling in a form that asks for your name, address, town,
postcode, and so on. After typing into one text box,
don’t reach for the mouse and click the next box – just
press the Tab key to jump straight into it.

Windows

The Windows flag key is one of the newer additions to
modern keyboard and you’ll usually find two of them
on the bottom row. You can use whichever is easier to
reach. By themselves they open the Start menu (or the
Start screen in Windows 8.1). They can also be used in
combination with other keys to carry out particular
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actions in Windows: Win+E to open File Explorer, Win+D
to minimise all open Windows and return you to the
desktop; Win+I to open Windows 10’s Settings app; and
Win+L to lock your PC.

Keys May Behave Differently in Certain
Programs!

What I’ve described above are the ways the keys are
supposed to work. However, it’s important to remember
that the final choice about what many keys do rests with
the people who write the programs you use.

To take one example, I mentioned that the F1 key is
traditionally used to display a program’s built-in help
file. Although traditional, there’s nothing to enforce
this: some programs don’t include a help file, so the F1
key probably won’t do anything in those programs;
similarly, the programmer may have taken the unusual
decision to make you press a different key for help.

Programs watch which keys you press, or which
combinations of keys, and do whatever they were
programmed to do in response. Fortunately, most
programmers are sensible folk who realise that we
expect certain things to happen when we press
particular keys, and make sure their program behaves as
we expect. (They also know that if their program is too
peculiar, no-one will use it!)

This freedom does lead to one extra point, though.
Although some of the old keys like Scroll Lock and Pause
are usually redundant, there’s nothing to stop a
particular programmer from putting them to good use!
Although Windows itself takes no notice of these keys,
you may one day come across a program in which these
keys do something useful again.
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